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Лабораторна робота № 1 

Тема. Виділення фрагментів зображення. Переміщення, 

дублювання, редагування і заливка виділених зображень. 

Мета. Вміти виділяти об’єкти для подальшої роботи з ними. 

Теоретичні відомості 

Для виконання певних дій з окремим об’єктом чи довільним 

фрагментом растрового зображення, його спочатку необхідно 

виділити. Частина зображення, яка не потрапила у виділену область, 

називається маскованою або закритою маскою. Після виділення 

області зображення, всі виконувані дії будуть стосуватись лише 

виділеної області. 

В програмі Adobe Photoshop є можливість створення областей 

виділення правильної форми, довільної форми і за кольором. Такі 

області створюються за допомогою трьох основних груп 

інструментів – Marquee (Область), Lasso (Ласо), Magic Wand 

(Чарівна паличка). Для переміщення виділених фрагментів 

використовують інструмент Move (Переміщення). 

Таблиця 1.1. 

Основні комбінації клавіш 

Клавіші та їх 

комбінації Опис операцій 

Tab 
виводить на екран / забирає панель інструментів, 

панель параметрів, відкриті палітри 

Shift + Tab виводить на екран / забирає всі відкриті палітри 

Ctrl + R включення / виключення координатної лінійки 
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Клавіші та їх 

комбінації Опис операцій 

Пробіл 
тимчасовий вибір інструмента Hand (Рука), коли 

вибрано інший інструмент 

Ctrl + 0 

вписати зображення в екран (відбувається зміна 

масштабу документа т. ч., щоб він заповнив 

вільну частину екрану) 

Ctrl + Alt + 0 
встановлює для активного зображення масштаб 

100 % 

Ctrl + Tab переключення між відкритими вікнами 

Ctrl + Пробіл 
тимчасовий вибір інструмента Zoom In 

(Збільшити)  

Alt + Пробіл 
тимчасовий вибір інструмента Zoom Out 

(Зменшити)  

Ctrl 
тимчасовий вибір інструмента Move 

(Переміщення) 

Ctrl + + збільшити масштаб зображення 

Ctrl + - зменшити масштаб зображення 

Ctrl + D відміна поточного виділення 

F2 вирізає поточне виділення 

F3 копіює поточне виділення 

F4 вставка поточного виділення 

F5 
виводить на екран / забирає палітру Brushes 

(Пензлі) 

F6 
виводить на екран / забирає палітру Color 

(Колір) 

F7 
виводить на екран / забирає палітру Layers 

(Шари) 

F8 
виводить на екран / забирає палітру Info 

(Інформація) 

F12 відміна всіх виконаних дій 
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Хід роботи 

Виділення прямокутних і еліптичних областей 

1. Запустити програму Adobe Photoshop. 

2. Створити новий документ. Вказати ім’я, розмір 640 / 480 

пікселів, роздільна здатність 72 піксель / дюйм, кольоровий 

режим зображення RGB Color, фон білий. 

3. Створити область виділення прямокутної форми, застосувавши 

інструмент Rectangular Marquee Tool (M) (Прямокутна 

область). 

4. У палітрі Swatches (Зразки) вибрати колір для заливки 

прямокутника. Щоб вибрати колір для заливки, клацаємо на 

зразку вибраного кольору при натисненій клавіші Ctrl. 

5. Виконати заливку виділеної області, застосувавши інструмент 

Paint Bucket Tool (G) (Заливка). 

6. Вибрати колір фону. 

7. Виконати обведення, вказати товщину обведення (1 px). 

8. Відмінити поточну область виділення. 

9. Створити еліптичну область виділення. Виконати заливку і 

обведення даної області. 

Вказавши числове значення в полі введення Feather 

(Розтушовка) панелі параметрів інструмента виділення, можна 

створити область виділення з розмитими межами. Якщо таку область 

залити кольором, то межі об’єкта будуть нечіткими. Розтушовка 

виконується по обидва боки від контура виділення – всередину та 

назовні і може призвести до деякої втрати деталей на межі 

виділення. 
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Рис. 1.1. Області виділення. Дія параметра розтушовки на межу 

виділеної області 

10. Зберегти документ. 

11. Закрити документ. 

Комбінування різних типів виділення 

1. Відкрити створений файл. 

2. Виділити прямокутну область, що включає прямокутник і еліпс. 

 

Рис. 1.2. Прямокутна область виділення створена 

3. Перемістити створену прямокутну область виділення. 

 

Рис. 1.3. Переміщення прямокутної області виділення 
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4. Відмінити переміщення виділеної області. 

 

Рис. 1.4. Прямокутна область виділення 

5. Виключити з виділеної області прямокутник: вибрати Magic 

Wand Tool (W) (Чарівна паличка) на панелі інструментів; 

натиснути кнопку Subtract from selection (відняти від виділення) 

на панелі параметрів; встановити вказівник миші на 

прямокутнику (знак “-” біля вказівника вказує, що відбувається 

виключення з області виділення) і клацнути ЛКМ. Прямокутник 

буде обмежений пунктирною рамкою і виключений з області 

виділення. 

6. Виключити з виділеної області еліпс. 

 

Рис. 1.5. Прямокутник і еліпс виключені з виділеної області 

7. Перемістити виділену область, щоб переконатись, що 

прямокутник і еліпс виключені з області виділення (для 

тимчасового включення інструмента Move Tool (V), при 

переміщенні утримуємо натиснену клавішу Ctrl). 
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Рис. 1.6. Переміщення виділеної області 

8. Відмінити переміщення. 

9. Додати до області виділення прямокутник і еліпс, які були 

виключені: вибрати Magic Wand Tool (W) на панелі 

інструментів; натиснути кнопку Add to selection (додати до 

виділення) на панелі параметрів; встановити вказівник миші на 

прямокутнику (знак “+” біля вказівника вказує, що до області 

виділення буде додана нова область); клацнути ЛКМ. 

Прямокутник буде доданий до виділеної області. Клацнути на 

еліпсі. 

 

Рис. 1.7. Прямокутник і еліпс додано до виділеної області 

10. Вибрати Lasso Tool (L) (Ласо) на панелі інструментів. 

Нарисувати довільний замкнений контур біля верхнього лівого 

кута прямокутної рамки виділення. Область неправильної форми 

буде додана до прямокутного виділення. 
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Рис. 1.8. Область неправильної форми додано до виділеної області 

11. Натиснути кнопку Subtract to selection (відняти від виділення). 

Нарисувати довільний замкнений контур біля верхнього правого 

кута прямокутної рамки (вказівник миші прийме форму ласо із 

знаком “-”. Вказана ЛКМ область буде виключена із існуючого 

виділення. 

 

 

Рис. 1.9. Область неправильної форми виключено із виділеної 

області 

12. Натиснути кнопку Intersect with selection (перетин з 

виділенням). Встановити вказівник миші за межами виділеної 

області. Нарисувати довільний замкнений контур, щоб він 

перетинав існуюче виділення. Область виділення буде включати 

лише спільну частину обох виділень. 

 

Рис. 1.10. Область перетину виділених областей 
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Виділення прямокутних об’єктів 

1. Відкрити файл 01.tif з папки Lab1. 

 

Рис. 1.11. Файл 01.tif з папки Lab1 

2. Збільшити масштаб. 

3. Виділити зображення діалогу. 

4.  Зменшити масштаб до 100 %. 

5. Видалити фон: інвертувати зображення, виконавши Select 

(Виділення) → Inverse (Інвертувати) або Shift+Ctrl+I; вибрати 

колір за замовчуванням; натиснути Delete. 

 

Рис. 1.12. Фон рисунка видалений 

6. Вирізати зображення діалогу: відмінити очистку; інвертувати 

виділення, виконати Image (Зображення) → Crop (Кадрувати). 

 

Рис. 1.13. Зображення діалогу вирізано 
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7. Зберегти документ. 

8. Закрити документ. 

Виділення еліптичних об’єктів 

1. Відкрити файл 02.tif з папки Lab1. 

 

Рис. 1.14. Файл 02.tif з папки Lab1 

2. Вивести палітру Navigator (Навігатор). 

3. За допомогою палітри Navigator збільшити масштаб. 

4. Перемістити червоний прямокутник на мініатюрі палітри т. ч., 

щоб він обмежив об’єкт. 

 

Рис. 1.15. Палітра Navigator після переміщення і зміни масштабу 

зображення 

5. Виділити об’єкт. 

6. Зменшити масштаб зображення. 

7. Перемістити контур виділення. 

8. Відмінити переміщення контура виділення. 

9. Перемістити виділений об’єкт. 
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10. Відмінити переміщення об’єкта. 

11. Зробити копію зображення об’єкта: утримуючи клавішу Alt, 

перемістити виділений об’єкт. 

12. Зменшити розмір копії зображення об’єкта: зробити активною 

команду Show Bounding Box (Показати обмежувальну рамку) на 

панелі параметрів; зменшити розміри, утримуючи клавішу Shift 

для збереження пропорцій; двічі клацнути ЛКМ всередині 

прямокутника, щоб закріпити нові розміри; вимкнути прапорець 

Show Bounding Box. 

13. Виконати корекцію знебарвлення Desaturate або Shift+Ctrl+U. 

 

Рис. 1.16. Дублювання і редагування об’єкта 

14. Зберегти документ. 

15. Закрити документ. 

Виділення за допомогою Magic Wand Tool (W) 

1. Відкрити файл 03.tif з папки Lab1. 

 

Рис. 1.17. Файл 03.tif з папки Lab1 
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2. Виділити квітку, вибравши Magic Wand Tool (W) на панелі 

інструментів: виділити фон, після чого інвертувати виділення. 

3. Зменшити розмір квітки в два рази: Edit (Редагування) → 

Transform (Трансформація) → Scale (Масштаб). 

4. Створити п’ять копій квітки і заповнити ними малюнок. 

 

Рис. 1.18. Дублювання і редагування об’єкта 

5. Зберегти документ. 

6. Закрити документ. 

7. Відкрити файл 04.tif з папки Lab1. 

 

Рис. 1.19. Файл 04.tif з папки Lab1 

8. Вибравши Magic Wand Tool (W) на панелі інструментів, 

виділити одночасно всі об’єкти. 

 

Рис. 1.20. Виділення всіх областей вказаного кольору 

9. Відмінити виділення. 
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10. Виділити лише букву Я і перемістити її у верхній лівий кут. 

 

Рис. 1.21. Переміщення виділеного об’єкта 

11. Вибрати інструмент Crop Tool (C) (Кадрування). Cтворити 

кадруючу рамку для об’єкта Я. Натиснути клавішу Enter. 

 

Рис. 1.22. Кадруюча рамка для об’єкта Я 

Виділення за допомогою Magnetic Lasso Tool (L). Комбінування 

різних типів виділення 

1. Відкрити файл 05.tif з папки Lab1. 

 

Рис. 1.23. Файл 05.tif з папки Lab1 

2. Збільшити масштаб до 200 – 300 % і розгорнути вікно на весь 

екран. 
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3. Вибрати Magnetic Lasso Tool (L) (Магнітне Ласо) на панелі 

інструментів. 

4. Забрати з екрану панель інструментів, панель параметрів, палітри. 

5. Встановити вказівник біля верхнього краю чашки і клацнути 

ЛКМ. Переміщати вказівник вздовж контура. Замкнути контур, 

клацнувши ЛКМ на першій зв’язній точці. 

6. Зменшити розмір вікна і зображення таким чином, щоб воно 

поміщалось у вікно. 

7. Вибрати Magic Wand Tool (W) на панелі інструментів. 

Натиснути клавішу Alt і не відпускаючи, її клацнути ЛКМ на фоні 

всередині ручки. 

 

Рис. 1.24. Зображення чашки виділено 

8. Зберегти створене виділення: Select (Виділення)→ Save Selection 

(Зберегти Виділення…). Ввести ім’я. Натиснути кнопку OK у 

діалоговому вікні. 

 

Рис. 1.25. Діалогове вікно Save Selection 
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9. Аналогічно за допомогою Magnetic Lasso Tool (L) (Магнітне 

Ласо) виділити серце. 

10. Завантажити виділену чашку: Select (Виділення) → Load 

Selection (Завантажити Виділення); активізувати команду Add 

to Selection (Додати до виділення). Натиснути кнопку OK у 

діалоговому вікні. 

 

Рис. 1.26. Діалогове вікно Load Selection 

11. Перемістити виділені об’єкти у вікно файлу 04.tif з папки Lab1. 

12. Отримати наступний результат: 

 

Рис. 1.27. Комбінування виділених об’єктів 

13. Зберегти документ. 

14. Закрити вікна відкритих документів. 
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Виділення за допомогою Polygonal Lasso Tool (L) (Полігональне 

Ласо) 

1. Відкрити файл 06.tif з папки Lab1. 

  

Рис. 1.28. Файл 06.tif з папки Lab1 

2. Збільшити зображення об’єкта і помістити його в центрі вікна 

документа. 

3. Вибрати Polygonal Lasso Tool (L) на панелі інструментів. 

Виділити зображення об’єкта. 

4. Підігнати малюнок до розмірів вікна документа. 

5. Створити три копії об’єкта і заповнити ними малюнок. 

 

Рис. 1.29. Редагування та дублювання об’єкта 

6. Зберегти документ. 

7. Закрити документ. 

Завдання для самостійного опрацювання 

Приклад. Дано зображення двох дверей (файли 07.jpg і 08.jpg з 

папки Lab1). Перетворити друге зображення – перші двері поставити 

на місце других. 
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Рис. 1.30. Файли 07.jpg, 08.jpg з папки Lab1 

Двері мають різний радіус заокруглення верхньої частини, тому 

верхній заокруглений фрагмент дверей перетворюємо окремо від 

прямокутної області. 

Послідовність виконання дій: 

1. Вибравши Elliptical Marquee Tool (M), виділити на першому 

рисунку фрагмент зображення, що відповідає заокругленості. 

2. Відійняти з отриманого еліпса за допомогою прямокутного 

виділення нижній фрагмент. 

3. Перемістити його на другий рисунок. 

4. Масштабувати фрагмент дверей (отриманий у такий спосіб 

фрагмент – це новий шар). 

5. Вибравши Rectangular Marquee Tool (M), виділити на першому 

рисунку другий фрагмент зображення. 

6. Перемістити його на другий рисунок. 

7. Масштабувати другий фрагмент дверей, при необхідності шари 

можна об’єднати. 
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Завдання 1. Здійснити “обмін” дверей (файли 09.jpg, 10.jpg, 11.jpg, 

12.jpg з папки Lab1). 

                

Рис. 1.31. Файли 09.jpg, 10.jpg, 11.jpg, 12.jpg з папки Lab1 

Контрольні запитання 

1. З яких елементів складається основне вікно графічного 

редактора Adobe Photoshop? 

2. Налаштування інтерфейсу Adobe Photoshop. 

3. Налаштування параметрів Adobe Photoshop (Ctrl + K). 

4. Як під час створення нового малюнка задати його розміри та 

роздільну здатність? 

5. Зміна масштабу відображення і переміщення по документу. 

6. Які інструменти призначені для виділення фрагмента 

зображення? 

7. Для чого призначені інструменти групи Ласо? 

8. Назвіть способи виділення фрагментів зображення. 

9. Чим відрізняється виділення прямокутною або еліптичною 

межами з натиснутою клавішею Shift і без неї? 

10. Чим відрізняється виділення прямокутною або еліптичною 

межами з натисненою клавішею Alt і без неї? 
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11. Як змінюється курсор миші в ході виділення Полігональним 

ласо, коли виділення підходить до вихідної точки, тобто контур 

замикається? 

12. Яким має бути малюнок, щоб зміна параметра Tolerans (Допуск) 

інструмента Magic Wand в межах від 0 до 255 не впливала на 

результат виділення? 

13. Чи можна за допомогою Ласо виділити кілька не пов’язаних між 

собою областей малюнка? 

14. Як параметр Width (Ширина) інструмента Lasso (Ласо) впливає 

на виділену область? 

15. Як виділити на зображенні фрагмент висотою 2 ppi і шириною, 

що дорівнює ширині зображення? 

16. Дублювання і редагування виділених зображень. 

17. Як перемістити виділений фрагмент зображення? 

18. Як отримати копію виділеного фрагмента зображення? 

19. Як трансформувати виділений фрагмент? 

20. Як повернути виділений фрагмент на заданий кут? 

21. Як зняти виділення з позначеної області? 

22. Чим відрізняються у використанні інструмент Заливка (G) і 

команда Редагування → Залити…(Shift+F5)? 

23. За допомогою якої команди можна обвести контур виділення? 

24. Чи можна задати товщину контуру виділення? Як він може бути 

розташований? 

25. Призначення інструмента Eyedropper (Піпетка). 
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Лабораторна робота № 2 

Тема. Корекція, ретушування і відновлення фотозображень. 

Мета. Вміти виконувати основні операції над фотозображенням. 

Хід роботи 

Поворот зображення 

1. Відкрити файл 01.jpg з папки Lab2. Розглянути розмір файлу, 

роздільну здатність. Точне значення розмірів зображення (в 

дюймах) можна отримати, поділивши висоту (ширину) на 

роздільну здатність. 

 

Рис. 2.1. Файл 01.jpg з папки Lab2 

2. Включити координатну лінійку. 

3. Повернути зображення на 90 за годинниковою стрілкою: Image 

(Зображення) → Image Rotation Canvas (Поворот 

зображення)  → 90 Clockwise (За годинниковою стрілкою). 

4. Повернути зображення у вихідне положення. 

5. Відобразити дзеркально зображення по горизонталі. 

6. Зберегти зображення в форматі TIFF. 
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Збереження зображення в форматі TIFF 

Якщо обробка зображення в програмі Adobe Photoshop буде 

продовжуватись, то для збереження можна використовувати 

власний формат Adobe Photoshop – PSD або формат TIFF. В Adobe 

Photoshop розширення формату TIFF можуть містити зображення, 

стиснуті алгоритмами ZIP і JPEG. Алгоритми стиску ZIP і JPEG 

всередині формату TIFF підтримують не всі програми редагування 

растрової графіки. Тому краще використовувати формат TIFF без 

компресії. В цьому випадку можна буде редагувати зображення в 

будь-яких інших програмах обробки графіки. При постійному 

відкриванні і збереженні JPEG-файлу можна пошкодити 

зображення. Формати PSD і TIFF (з компресією LZW чи без неї) не 

мають цього недоліку. 

1. Виконати File → Save As. 

2. Вибрати папку, в якій буде збережено зображення. Ввести ім’я 

файлу. 

3. В списку Тип файлу вибрати TIFF (*.TIF, *.TIFF). 

4. Активізація Save As Copy означає зберегти копію файлу і 

продовжити роботу з оригіналом. 

5. Натиснути Зберегти. 

6. У діалоговому вікні TIFF Options вибрати платформу IBM PC, 

компресію LZW, щоб стиснути файл без втрати якості і мати 

змогу редагувати в будь-якій іншій програмі. ОК. 

Багатошарові зображення можуть бути збережені лише в 

форматах TIFF і PSD. Якщо фотографія призначається для 
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Інтернету, то після редагування необхідно зберегти фото в форматі 

JPEG з метою зменшення розміру файлу. 

Трансформація виділеного об’єкта 

1. Відкрити файл 01.tiff. 

2. Виділити листок. 

3. Створити новий документ. 

4. Перемістити відокремлений від фону листок у створений 

документ. 

5. Зменшити розмір листка. 

6. Створити три копії листка. 

7. Застосувати до листків команди трансформації 

(Edit → Transform). 

 

Рис. 2.2. Трансформація об’єктів 

8. Зберегти документ. 

9. Закрити документ. 

Кадрування зображення 

1.  Відкрити файл 02.jpg з папки Lab2. 
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Рис. 2.3. Файл 02.jpg з папки Lab2 

2. Здійснити обрізку фото знизу, надавши композиції просторову 

глибину: створити прямокутну область виділення, вказавши межі 

обрізки (інструмент Rectangular Marquee Tool (M): ширина – 

5,419 см, висота – 3,2 см); здійснити кадрування зображення 

(Image → Crop); відмінити виділення. 

 

Рис. 2.4. Кадрування зображення 

3. Зберегти документ. 

4. Закрити документ. 

Поворот і одночасне кадрування зображення 

1. Відкрити файл 03.jpg з папки Lab2. 
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Рис. 2.5. Файл 03.jpg з папки Lab2 

2.  Здійснити поворот і одночасно обрізку зображення, 

використовуючи інструмент Crop Tool (C) (Рамка). 

3. Зберегти документ. 

4. Закрити документ. 

Динамічний діапазон і тонова корекція 

Якість зображення залежить від його динамічного діапазону. 

Динамічний діапазон – різниця між найсвітлішим і найтемнішим 

кольором. Дуже часто кольори на зображеннях, особливо 

сканованих, незбалансовані – зображення не контрастне (або дуже 

темне, або дуже світле). При розширенні динамічного діапазону 

програма перераховує значення кольорів зображення таким чином, 

щоб зайняти весь можливий кольоровий спектр. В результаті світлі 

кольори стають світлішими, а темні – темнішими, що сприймається 

оком як збільшення контрастності. 

Тонова корекція зображення виконується за допомогою 

гістограми. Гістограма – графік розподілу в зображенні рівнів 

яскравості пікселів. По горизонтальній осі відкладені значення 

яскравості від 0 до 255. Темні тона розташовані зліва, а світлі – 



28 

 

справа. По вертикалі відкладається кількість пікселів з даними 

значеннями яскравості. Якщо пікселі розташовуються рівномірно, 

по всьому тоновому діапазоні від лівого краю графіка до правого, то 

таке зображення хорошої якості. Поля вводу Output Levels (Вихідні 

рівні) призначені для зниження констрастності в зображенні. 

Чорний трикутник управляє тінями, а білий – світлими областями. 

1. Відкрити файл 03.jpg з папки Lab2. 

2. Відкрити палітру Histogram (Гістограма). 

 

Рис. 2.6. Палітра Histogram 

Основна маса пікселів розташована ближче до правого краю 

гістограми, що означає, що зображення дуже світле. 

3. Скоригувати новий діапазон: Image (Зображення) → Adjustments 

(Корекції) → Levels (Рівні) або Ctrl +L. 

 

Рис. 2.7. Діалогове вікно Levels 
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Вказати початок і кінець гістограми, розтягнувши її на весь діапазон 

яскравості. Зробити активною опцію Preview (Попередній 

перегляд), щоб результати корекції відображались у вікні документа. 

Чорний і білий трикутники на краях гістограми позначають 

відповідно чорну і білу точки. Якщо чорний трикутник переміщати 

вправо, то всі значення яскравості пікселів зліва від нього будуть 

рівними 0, чи чорному кольору. Якщо білий трикутник переміщати 

вліво, то значення яскравості всіх пікселів справа від нього будуть 

рівні 255 чи білому кольору. На фотографії гістограма зміщена 

вправо, тому перерозподіл білої точки не потребується. Задати нову 

границю чорного (чорну точку), перемістивши чорний трикутник 

вправо, щоб у полі Input Levels з’явилось числове значення 98 – всі 

пікселі, які розташовані на гістограмі лівіше чорного трикутника (з 

рівнем яскравості менше 99) отримали числове значення яскравості 

0 – стали абсолютно чорними). Перемістити сірий трикутник, щоб в 

полі Input Levels було значення 0,94. Сірий трикутник регулює 

контрастність в середніх тонах (яскравість проміжних тонів). 

Програма перерозподілить значення яскравості пікселів, і фото стане 

світлішим. OK. 

Після перерозподілу чорної і сірої точок, в палітрі Histogram 

з’явились білі пробіли між чорними вертикальними лініями 

яскравості. Так позначаються рівні яскравості, яким на фотографії не 

відповідає жоден піксель. Якщо пробіли не дуже широкі, вони 

суттєво не впливають на якість зображення. 

4. Закрити файл, не зберігаючи змін. 

5. Відкрити файл 04.jpg з папки Lab2. 
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6. Відкоригувати тоновий діапазон, виконавши автоматичну тонову 

корекцію: Image (Зображення) → Adjustments (Корекції) → 

Auto Levels (Автоматична тонова корекція) або Shift + Ctrl + L. 

Команда Auto Levels визначає в зображенні найсвітліший і 

найтемніший пікселі як білий і чорний, і пропорційно 

перерозподіляє кольорові значення всіх пікселів в межах 

розширеного інтервалу. Використовувати дану команду можна в тих 

випадках, коли в зображенні необхідно лише просте налаштування з 

рівномірним розподілом кольорових значень пікселів. Більш точна 

тонова корекція виконується за допомогою діалогу Levels. 

 

Рис. 2.8. Автоматична тонова корекція зображення 

7. Зберегти документ. 

8. Закрити документ. 

Заміна кольору в зображенні 

За допомогою команди Image (Зображення) → Adjustments 

(Корекції) → Replace Color (Заміна кольору) можна здійснити 

заміну кольору будь-якого об’єкта при умові, що даний колір добре 

контрастує із оточуючим фоном. 
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Рис. 2.9. Діалогове вікно Replace Color 

Параметри вікна Replace Color: 

 – Виділяє один колір. 

 – Додає кольори до виділеної області. 

 – Виключає колір з виділеної області. 

Переміщення повзункового регулятора Fuzziness (Розмитість) 

вправо додає до вибраних кольорів близькі відтінки, вліво – видаляє 

близькі відтінки. При активній опції Image (Зображення) у вікні 

перегляду відображається поточне зображення; при активній опції 

Selection (Виділення) – поточне виділення чи маска. Білі ділянки 

маски означають виділені області, чорні – масковані, сірі – частково 

масковані. 

1. Відкрити файл 04.jpg з папки Lab2. Жовтий колір квітів добре 

контрастує із зеленим фоном. Тому його легко можна змінити. 
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Рис. 2.10. Файл 04.jpg з папки Lab2 

2. Виконати Image → Adjustments → Replace Color. 

3. Вказати колір, який має бути виділений: вибрати першу піпетку; 

встановити вказівник у вікні документа на жовтому кольорі; 

клацнути ЛКМ. 

4. Розширити виділену область: вибрати другу піпетку (із знаком 

„+”); встановити вказівник на квітці з іншим відтінком жовтого; 

тримаючи ЛКМ, переміщати піпетку по ділянках жовтого 

кольору різних відтінків. 

5. Активізувати опцію Preview, щоб результати корекції 

відображались у вікні документа. Переміщаючи повзункові 

регулятори Hue (Тон), Saturation (Насиченість), Lightness 

(Яскравість) можна спостерігати у вікні документа, як змінюється 

колір, насиченість і яскравість виділеної області. 

6. Встановити значення Hue   - 29, Saturation   +24, Lightness   0. OK. 
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Рис. 2.11. Заміна кольору в зображенні 

7. Зберегти документ. 

8. Закрити документ. 

Інструмент Clone Stamp Tool (S) (Штамп клонування) 

1. Відкрити файл 05.jpg з папки Lab2. 

 

Рис. 2.12. Файл 05.jpg з папки Lab2 

2. Видалити зігнуті прутики за допомогою інструмента Clone Stamp 

Tool (S): 

a. Збільшити масштаб фото до 200 % і перемістити перший 

зліва прутик в центр за допомогою палітри Navigator. 

b. Вибрати Clone Stamp Tool (S). 

c. На панелі параметрів вибрати м’який пензлик, діаметром 

більшим за діаметр прутиків наприклад, 10 пк і жорсткістю 

0 %, Mode (Режим) – Normal (Звичайний), Opacity 
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(Непрозорість) – 100 %, Flow (Натиск) – 100 %. Активізувати 

опцію Aligned (Вирівнювання). 

У списку Mode задається режим змішування при накладанні 

пензликом нової фарби поверх існуючої. Залежно від вибраного 

режиму, результуюче зображення може бути більш темним чи більш 

світлим за попереднє. При вибраному режимі Normal, результуючий 

колір буде обчислений, як суміш вихідного і накладеного кольорів з 

врахуванням прозорості. 

При неактивній опції Aligned (Вирівнювання), зразок для 

кожного нового мазка пензлика береться з однієї і тієї ж точки (в якій 

вибрано зразок для клонування при натисненій клавіші Alt). 

При активній опції Aligned, зразок для кожного нового мазка 

пензлика береться в іншому місці. На прут накладається зображення, 

яке береться звідти, куди вказує хрестик біля вказівника. 

d. Встановити вказівник внизу, справа від першого прута. 

Натиснути Alt, і не відпускаючи її, клацнути ЛКМ. 

Відпустити Alt. Зразок для клонування взято. 

e. Встановити вказівник в правому нижньому кінці прута. 

Тримаючи ЛКМ, переміщати вказівник вверх по пруту, 

замальовуючи його взятим зразком. 

f. Видалити аналогічно інші прутики. 

 

Рис. 2.13. Результат застосування Clone Stamp Tool (S) 
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3. Зберегти документ. 

4. Закрити документ. 

Відновлення елементів зображення за допомогою Patch Tool (S) 

(Заплата) 

Інструмент Patch Tool (S), як і клонуючий штамп, копіює 

вказаний фрагмент фотографії в інше місце зображення, але не 

пензликом, а шляхом виділення області і переміщення її в нове 

місце. В якості заплати можна вибирати не фрагмент, а текстуру, яка 

після виділення області вибирається в палітрі Use Pattern. 

1. Відкрити файл 06.jpg з папки Lab2. 

 

Рис. 2.14. Файл 06.jpg з папки Lab2 

2. Збільшити масштаб. 

3. Вибрати інструмент Patch Tool (S). 

4. Виділити пошкоджену область крила, щоб замінити її іншим 

фрагментом. 

5. Помістити вказівник миші у виділену область і перемістити 

вправо і вверх. Разом з ним переміститься копія контура 

виділення, який замінить пошкоджену частину крила.  
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Рис. 2.15. Результат застосування Patch Tool (S) 

6. Відмінити виділення.  

7. Зберегти документ. 

8. Закрити документ. 

Видалення елементів зображення за допомогою Patch Tool (S) 

1. Відкрити файл 07.jpg з папки Lab2. 

 

Рис. 2.16. Файл 07.jpg з папки Lab2 

2. Видалити трубу: 

a. Вибрати інструмент Patch Tool (S). 

b. Намалювати контур навколо труби. 

c. Активізувати опцію Sourse (Джерело) на панелі параметрів. 

d. Перемістити виділену область вправо. 

e. Відмінити виділення. 
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Інструмент Patch Tool (S) підганяє клонуючий фрагмент до 

навколишнього фону: освітлює, затемнює, міняє колір і текстуру. 

3. Зберегти документ. 

4. Закрити документ. 

Інструмент Healing Brush Tool (J) (Лікувальний пензель) 

На відміну від Clone Stamp Tool (S), при використанні Healing 

Brush Tool (J), копіюючий фрагмент зображення відтворюється з 

урахуванням текстури, прозорості і освітленості поточного 

фонового зображення. В результаті відбувається об’єднання 

копіюючого і фонового зображень. 

1. Відкрити файл 08.jpg з папки Lab2. 

 

Рис. 2.17. Файл 08.jpg з папки Lab2 

2. Збільшити масштаб до 200 %. 

3. За допомогою Healing Brush Tool (J) видалити морщини на лобі: 

a.  Вибрати діаметр пензлика 8 пк, жорсткість 0, Spasing 

(Інтервали) – 25 % (визначає відстань між сусідніми 

штрихами і задається в процентах від діаметра), Mode – 

Normal. Активізувати Sampled (Зразок) і Alignet. 

b. Взяти зразок для клонуваня над правим краєм верхньої 

морщини лоба. 
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c. Замалювати всі горизонтальні морщини лоба. При 

необхідності змінювати місце взяття зразка, розмір пензлика. 

Видалити вертикальні морщини між бровами. 

4. Вибрати інструмент Patch Tool (S). Активізувати Sourse. Зробити 

неактивним Transparent (Прозорість). Накласти заплату на 

морщини в нижній частині лиця. 

5. Надати портрету природність: 

a. Помістити портрет на окремий шар і зробити цей шар 

частково прозорим: скопіювати зображення в буфер обміну 

Select → All, Edit → Copy; відмінити виділення; відновити у 

вікні документа вихідне зображення (File → Revert); 

вставити з буфера обміну в активний документ 

відретушоване зображення Edit → Paste. Відретушоване 

зображення буде поміщено на новий шар. 

b. Порівняти зображення до і після ретушування. 

c. Встановити значення Opacity шару Layer1 60 %. 

 

Рис. 2.18. Видалення морщин на лиці 

6. Порівняти вихідне і кориговане зображення.  

7. Об’єднати шари для зменшення розміру файлу Flatten Image. 

8. Зберегти документ. 

9. Закрити документ. 
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Завдання для самостійного опрацювання 

Завдання 1. Відкрити файл 09.jpg з папки Lab2. 

 

Рис. 2.19. Файл 09.jpg з папки Lab2 

Перетворити колір кроликів: один має стати білим із сірим 

відтінком, другий – майже чорним, третій – трохи змінити сірий 

колір. Відкоригувати тон блакитного фону і колір листя. 

Послідовність виконання дій: 

 

Рис. 2.20. Зміна колірного балансу зображення першого кролика 

 

Рис. 2.21. Зміна колірного тону та насиченості кольору зображення 

другого кролика 
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Рис. 2.22. Зміна колірного тону та насиченості кольору зображення 

третього кролика 

 

Рис. 2.23. Зміна колірного тону та насиченості листя 

 

Рис. 2.24. Зміна колірного тону та насиченості фону 

Завдання 2. Відкрити файл 10.jpg з папки Lab2. Змінити яскравість, 

контраст і баланс кольорів для зображень. 
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Рис. 2.25. Зміна яскравості, контрасту і балансу кольорів 

Завдання 3. Відкрити файл 11.jpg з папки Lab2. За допомогою 

клонуючого штампу відновити відсутній елемент зображення, 

попередньо інструментом Lasso Tool (L) виділити фрагмент крила, 

який втрачений, щоб при клонуванні не виходити за його межі. 

Завдання 4. Відкрити файл 12.jpg з папки Lab2. За допомогою 

інструмента Red Eye (J) усунути ефект червоних очей. 

Контрольні запитання 

1. Як змінити фізичний розмір зображення? 

2. Що таке логічний розмір зображення? 

3. Які кольори є в колірному колі? 

4. Які кольори називаються комплементарними? 

5. Як можна збільшити частку червоного кольору в зображенні? 

6. Які можливості налаштування Color Balance? 

7. Які можливості налаштування колірного тону, насиченості та 

яскравості зображення? 

8. Яких значень можуть набувати характеристики Hue, Saturation, 

Lightness? 

9. Як впливає на зображення налаштування Brightness? 
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10. Як впливає на зображення налаштування Contrast? 

11. Як отримати інформацію про колірний режим зображення? 

12. Коли необхідно змінювати колірний режим? 

13. Як змінити колірний режим зображення? 

14. Що таке глибина роздільної здатності кольору? 

15. Які можливості інструментів групи Stamp (S)? 

16. Які інструменти входять у групу Eraser (E)? Яке їхнє 

призначення? 

17. Назвіть інструменти тонування зображень. 

18. Назвіть інструменти, що розмивають зображення. 

19. Які можливості інструмента Crop? 

20. Система відміни дій. Палітра History. 

Лабораторна робота № 3 

Тема. Робота з шарами зображення. Створення віньєтки. 

Мета. Ознайомитись з основними прийомами роботи з шарами. 

Вміти редагувати об'єкт на одному шарі, не впливаючи на інші, 

змінювати композицію, коригуючи порядок і розташування 

шарів. 

Теоретичні відомості 

Зображення в Adobe Photoshop складається з одного чи кількох 

шарів. Шари дають можливість редагувати окремі елементи 

зображення незалежно один від одного. Кожен шар документа має ті 

ж розміри, роздільну здатність, колірну модель, що і основний 

малюнок. Це дає можливість копіювати і переміщати об’єкти з шару 
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на шар, виконувати різні операції з шарами. Додавання шарів 

призводить до збільшення об’єму документа. Прозорі ділянки шарів 

не впливають на розмір файлу. При створенні документ складається 

з одного шару, який за замовчуванням називається Background 

(Фон). 

Палітра Layers (Шари) використовується для створення, 

переміщення дублювання, об’єднання і знищення шарів, дозволяє 

керувати відображенням окремих шарів. В палітрі Layers 

відображаються всі шари, які є на малюнку, починаючи з верхнього. 

Зліва від імені кожного шару знаходиться картинка із вмістом шару. 

Сірий шахматний узор шару на картинці означає, що даний шар є 

прозорим. В кінці списку завжди знаходиться фоновий шар 

Background. Для фонового шару доступні не всі операції, тому для 

виконання різних перетворень, необхідно його замінити звичайним 

шаром. Всі команди редагування застосовуються лише до активного 

шару, який в палітрі виділяється темним кольором. Adobe Photoshop 

не обмежує кількість шарів, які можна створити в документі. Реальна 

їх кількість може бути обмежена можливостями комп’ютера. При 

збереження зображення із шарами застосовують власний формат 

програми Photoshop – формат PSD. 

Хід роботи 

1. Відкрити файл 01.psd з папки Lab3. 

2. Вивести на екран палітру Layers. 

Всі шари, які є на рисунку, починаючи з верхнього, відображені 

в палітрі Layers. Кожен шар має ім’я. В кінці списку знаходиться 

фоновий шар Background. Шахматний сірий узор означає, що в 
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даному місці шар абсолютно прозорий, і через нього видно нижні 

шари. 

3. Змінити способи відображення прозорості шару (величини 

шахматного узору, його колір). 

4. Розглянути шари, яких не видно, виключивши відображення 

вищерозташованих шарів. 

5. Зробити видимими всі шари зображень. 

6. Зробити активним шар Вітка і перемістити об’єкт на шарі Вітка. 

Інформація про активний шар міститься в заголовку. 

7. Використовуючи контекстне меню, перемістити об’єкт на шарі 

Полуниця. 

8. Перемістити зображення Апельсин і Яблуко т.ч., щоб вони 

частково перекривались. 

9. Помістити зображення Апельсин над зображенням Яблуко. 

10. Збільшити насиченість кольорів зображення Апельсин, 

виконавши корекції Hue Saturation (Насиченість тону). 

11. Застосувати до шару Апельсин ефекти стилю, наприклад, тінь 

обведення. 

12. Змінити непрозорість Opacity об’єктів активного шару 

Апельсин. 

13. Встановити для об’єкта на шарі Апельсин значення Opacity 

100 %. 

14. Розглянути поле Fill (Заповнення) палітри Layers. Як діє 

параметр Fill при налаштуванні ступеня прозорості шару? 

15. Розглянути режими змішування на палітрі Layers. 



45 

 

16. Застосовуючи інструмент Brush Tool (B), нарисувати довільний 

рисунок на шарі Апельсин, включаючи прозорі і непрозорі 

пікселі. 

17. Відмінити зміну рисунка за допомогою палітри History. 

18. Захистити активний шар, заборонивши редагування прозорих 

пікселів. 

19. Спробувати щось нарисувати на прозорій і непрозорій ділянках 

шару. 

20. Відмінити блокування прозорих пікселів. 

21. Захистити від змін всі пікселі шару: прозорі і непрозорі. 

22. Спробувати щось нарисувати на прозорій і непрозорій ділянках 

шару. 

23. Відмінити блокування пікселів. 

24. Перемістити зображення Апельсин. 

25. Виконати блокування переміщення об’єкта. 

26. Спробувати перемістити зображення Апельсин. 

27. Відмінити блокування переміщення. 

28. Зробити неможливим виконання всіх операцій редагування на 

шарі, дія Lock all. 

29. Спробувати виконати будь-які дії над шаром Апельсин. 

30. Перейменувати шар Апельсин. 

31. Створити новий шар. Виключити відображення всіх інших 

шарів. 

32. Створити на активному новому шарі об’єкт, застосувавши 

інструмент Custom Shape (U). 

33. Видалити створений шар. 
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34. Включити відображення шарів Яблуко, Полуниця, Вишня, 

Вітка. 

35. Створити із об’єктів Яблуко, Полуниця, Вишня, Вітка 

довільну композицію. 

36. Зв’язати шари т. ч., щоб можна було перемістити композицію. 

37. Відмінити зв’язування шарів. 

38. Створити набір шарів, назвавши його Композиція. Включити в 

набір шари Вітка, Вишня, Полуниця і Яблуко. 

39. Виключити відображення набору Композиція. 

40. Включити відображення шарів Роза і Лист. 

41. Створити дублікати шарів Роза і Лист. Розмістити їх 

симетрично. 

42. Об’єднати два послідовно розташованих шари, наприклад Роза 

copy і Роза (команда Merge Down або Ctrl+E). 

43. Перемістити рози. 

44. Відмінити команди Merge Down і Move. 

45. Об’єднати видимі шари, Merge Visible або Shift + Ctrl + E. 

46. Здійснити переміщення об’єктів. 

47. Відмінити команди Merge Visible і Move. 

48. Включити в палітрі відображення всіх шарів. 

49. Залити фон багатоколірним градієнтом. 

50. Коли редагування документа закінчено, можна об’єднати всі 

шари в один, Flatten Image. 
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Рис. 3.1. Композиція шарів 

51. Даний файл можна зберегти в довільному форматі, який 

підтримується програмою Adobe Photoshop. 

Створення віньєтки 

1. Відкрити файл 02.jpg з папки Lab3. 

 

Рис. 3.2. Файл 02.jpg з папки Lab3 

2. Перейменувати шар Background. 

3. Зберегти документ в форматі PSD. 

4. Нарисувати овал навколо лиця. 

5. Зробити границі контура розмитими 

Select → Modify → Feather або Shift + F6. Радіус розтушовки 30 

pixels. OK. 
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6. Інвертувати виділення і додати новий шар. Область виділення 

відноситься до активного шару Layers1. 

7. Залити виділену область білим кольором. 

8. Відмінити виділення. 

9. Обрізати краї фотографії. 

10. Об’єднати шари зображення. 

11. Зберегти документ як віньєтка.psd. 

12. Закрити документ. 

  

Рис. 3.3. Файл віньєтка.psd 

Завдання для самостійного опрацювання 

Завдання 1. Створити рамку для фотографії 

1. Відкрити файл віньєтка.psd. 

2. Збільшити ширину і висоту фотографії на 1 см, щоб виділити 

місце для рамки: 

a. Виконати Image → Canvas Size. 

b. Активізувати прапорець Relative (Відносні розміри). 

c. Ввести ширину 2 см і висоту 2 см. 

d. Вибрати будь-який колір. 

3. Вписати зображення у вікно документа. 
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4. Виділити рамку за допомогою Magic Wand Tool (W). 

5. Перенести рамку на новий шар Layer → New Layer via Cut 

(Новий шар за допомогою вирізання). 

6. Виділити непрозорі ділянки шару Layer1 (при натисненій Ctrl, 

клацнути ЛКМ на Layer1). 

7. Залити рамку текстурою під дерево Edit → Fill. У списку Use 

вибрати Pattern (Текстура). 

8. Відмінити виділення. 

9. Надати рамці рельєфність. 

10. Зберегти документ. 

11. Закрити документ. 

Завдання 2. Розглянути режими змішування 

1. Відкрити два будь-яких зображення, які будете накладати. 

2. Переглянути розміри двох малюнків Image → Image Size. 

Підібрати вдалі розміри. 

3. Розмістити два зображення у одному документі. Нове 

зображення матиме два шари. 

4. Розмістити шар одного із зображень за цільовий. 

5. На палітрі Layer вибрати режим змішування. 

6. Зберегти документ. 

7. Закрити документ. 

Завдання 3. Вставити зображення у форму 

1. Відкрити файл 03.jpg з папки Lab3. 
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Рис. 3.4. Файл 03.jpg з папки Lab3 

2. Виділити все зображення і скопіювати його в буфер обміну. 

3. Створити новий шар. 

4. Створити на новому шарі об’єкт, застосувавши інструмент 

Custom Shape (U). 

 

Рис. 3.5. Створена фігура 

5. Перетворити фігуру у виокремлену ділянку (клацнути ЛКМ на 

кнопці Load Path as a selection (Завантажити шлях як 

виділення)). 

6. Не знімаючи виділення з фігури, виконати Edit → Paste Into. 

 

Рис. 3.6. Вставка зображення у форму 
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7. Зберегти документ. 

8. Закрити документ. 

Контрольні запитання 

1. Що таке шар? 

2. Що таке одношарове і багатошарове зображення? 

3. Як називається єдиний шар зображення? 

4. Створення і видалення шарів. 

5. Що таке активний шар? 

6. Як зробити шар невидимим? 

7. Порядок накладання шарів. 

8. Способи вибору шарів. 

9. Як виконати редагування зображення на активному шарі? 

10. Як змінити прозорість шару? 

11. Як перетворити фон на шар? 

12. Режими змішування шарів. 

13. Захист шарів. 

14. Перейменування шарів. 

15. Зв’язування шарів. 

16. Копіювання шарів. 

17. Що таке група шарів? Як з нею працювати? 
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Лабораторна робота № 4 

Тема. Коригувальні шари. Маски шарів. 

Мета. Ознайомитись з технікою професійного редагування у 

програмі Adobe Photoshop. Набути навичок роботи з 

коригувальними шарами. 

Теоретичні відомості 

Крім звичайних шарів, на яких розміщуються зображення, в 

Adobe Photoshop використовуються додаткові, коригувальні шари, 

які виступають в ролі так званих фільтрів для нижче розташованих 

шарів. Коригувальні шари дозволяють вільно експериментувати з 

кольоровими і тоновими характеристиками зображення, не 

змінюючи при цьому вихідні графічні дані. Параметри 

налаштування, записані на коригувальному шарі, можуть діяти на 

всі шари зображення, розташовані під ним або лише на шар, який 

розташований під коригувальним. Коригувальні шари, маски, 

обрізні маски і стилі шарів дозволяють редагувати зображення і 

створювати витончені ефекти. 

Хід роботи 

1. Створити багатошаровий файл формату PSD з чотирьох файлів 

формату JPEG: 01.jpg, 02.jpg, 03.jpg, 04.jpg з папки Lab4: 

a. Відкрити файл 01.jpg. Перейменувати шар Background на 

Весна. 

b. Не закриваючи файл 01.jpg, відкрити файл 02.jpg. 

Перейменувати шар Background на Літо. 
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c. Скопіювати шар Літо з файлу 02.jpg в файл 01.jpg, для чого 

перемістити шар Літо з палітри Layers у вікно документа 

01.jpg і сумістити лівий нижній кут шару з лівим нижнім 

кутом вікна документа. Закрити файл 02.jpg. 

d. Аналогічні дії виконати з файлами 03.jpg, спочатку 

перейменувавши шар Background на Осінь і 04.jpg, 

перейменувавши шар Background на Зима. 

2. Змінити порядок розташування шарів в документі 01.jpg т. ч.: 

Весна, Літо, Осінь, Зима. 

 

Рис. 4.1. Шари документа в палітрі Layers 

3. Зберегти поточний документ в форматі PSD під назвою 01.psd, 

для подальшої роботи з коригувальними шарами. 

4. Перемістити кожен шар малюнку 01.psd вліво т. ч., щоб кожен з 

них займав четверту частину вікна. 
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Рис. 4.2. Розташування шарів на зображенні 

5. Зробити активним шар Весна. 

6. Створити коригувальний шар для корекції тонового балансу 

одночасно всіх шарів зображення: 

a. Виконати Layer → New Adjustment Layer  → Levels. На 

екрані з’явиться діалогове вікно New Layer. 

 

Рис. 4.3. Діалогове вікно New Layer 

В полі Name по замовчуванню пропонується ім'я шару Levels1. 

Якщо активізувати Use Previous Layer to Create Clipping Mask 

(Використовувати активний шар для створення обрізної маски), то 

налаштування рівнів можна буде застосувати лише до одного нижче 

розташованого шару. Розглянути, як налаштування діють на всі 

шари документа. Параметри Opacity і Mode дозволяють визначити 

ступінь непрозорості і режим змішування пікселів. Коригувальні 

шари набувають такі ж характеристики непрозорості і режиму 

змішування, що і реальні шари. OK. 
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b. В палітрі Layers стане активний новий коригувальний шар 

Levels1 (Рівні1), який коригує всі шари зображення. У стрічці 

коригувального чого шару є дві мініатюри:  Layer 

thumbnail (Мініатюра шару) наочно показує, що 

коригувальний шар коригує тонові рівні зображення; 

 Layer mask thumbnail (Мініатюра маски шару) буде 

відображати маску шару, коли вона буде створена. Значок у 

вигляді ланцюжка  Indicates layer mask is linked to layer 

(Індикація зв'язку маски шару із шаром) означає, що маска 

зв’язана з шаром. 

 

Рис. 4.4. Створено коригувальний шар Levels1, який коригує 

тоновий діапазон шару Весна 

7. Здійснити відповідні налаштування: 

a. Перемістити сірий трикутник під гістограмою вліво до 

значення, наприклад, 1,50. При цьому збільшиться яскравість 

середніх тонів на всіх шарах зображення. OK. 
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b. Виключити / включити видимість шару Levels1 для 

порівняння зображення з коригуванням рівнів і без 

коригування. Параметри коригування коригувального шару 

діють на всі шари документа. 

8. Відмінити застосування коригувального шару. 

Створити коригувальний шар, який буде діяти на всі нижче 

розташовані шари документа, можна також, клацнувши ЛКМ на 

піктограмі  Create new fill or adjustment layer (Створити новий 

заповнюючий або коригувальний шар) в нижній частині палітри 

Layers і в меню, яке з’явиться, вибрати тип шару. При цьому 

діалогове вікно New Layers не з’являється, а відразу відкривається 

діалог для налаштування параметрів шару. 

9. Створити коригувальні шари з індивідуальною для кожного шару 

корекцією параметрів. 

Для кожного шару зображення можна створити кілька 

коригувальних шарів. Щоб відкоригувати налаштування рівнів будь-

якого шару, необхідно двічі клацнути ЛКМ на мініатюрі  Layer 

thumbnail (Мініатюра шару) відповідного коригувального шару. 

Відкриється діалогове вікно Levels для зміни налаштувань. 

Порядок розташування коригувальних шарів 

Для кожного шару зображення можна створити кілька 

коригувальних шарів. Тоді вони будуть застосовуватись в 

послідовному порядку, знизу вверх: спочатку застосовується 

коригувальний шар, який розташований безпосередньо на шарі 

зображення, потім – коригувальний шар, який розташований на 
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першому коригувальному і т. д. Від порядку застосування 

коригувальних шарів залежить , як буде виглядати зображення. 

1. Створити новий коригувальний шар для регулювання відтінків і 

насиченості Hue / Saturation шару Осінь. Застосувати 

регулювання відтінків після налаштування рівнів: 

На шар Осінь діють два коригувальних шари: Levels3 і 

Hue / Saturation1. Спочатку застосовується шар Levels3, який 

налаштовує тоновий діапазон зображення, а потім – шар 

Hue / Saturation1, який коригує відтінок і насиченість. Якщо 

вимкнути видимість шару Hue / Saturation1, то на шар Осінь буде 

діяти лише шар Levels3. Змінити порядок застосування 

налаштовуючи шарів можна перемістивши їх у палітрі Layers. 

Крім коригувальних шарів можна створювати заливні шари, які 

містять параметри заливки нижче розташованих шарів. Заливні 

шари можуть бути трьох типів: Solid Color (Суцільний колір), 

Gradient (Градієнт), Pattern (Текстура). Шар із суцільною заливкою 

дозволяє тонувати зображення, підбираючи режим змішування і 

прозорість, режим із градієнтною заливкою створює плавні 

кольорові переходи, а шар із структурною заливкою – змінює вид 

поверхні об’єкта, покриваючи його текстурою. Для створення таких 

шарів виконуємо Layer → New Fill Layer (Новий шар заливки) або 

клацаємо ЛКМ на піктограмі  Create new fill or adjustment layer 

в нижній частині палітри Layers. 
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Створення маски шару 

Маска шару управляє ступенем “доступності” для обробки 

різних ділянок шару. Вносячи зміни в шар-маску, можна розглядати 

на шарі різні ефекти, не змінюючи при цьому його фактичного 

вмісту. Разом із багатошаровим документом можуть зберігатись всі 

створені в ньому маски шарів. 

Завдання. За допомогою масок-шарів створити з поточного 

документа композицію “Пори року”, де виконати плавний перехід 

від одного шару до інших. 

1. Створити маску шару Весна: 

a. Зробити активним шар Весна. 

b. виконати Layer → Layer Mask (Маска шару) → Hide All 

(Приховати все). Маска шару буде створена і в палітрі 

Layers, зліва від назви шару Весна з’явиться мініатюра  

Layer mask thumbnail (Мініатюра маски шару). 
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Рис. 4.5. Створена маска шару Весна 

Створена шар-маска автоматично стане активною, на що вказує 

біла рамка навколо мініатюри. Маска шару є чорно-біле півтонове 

зображення. Чорним кольором в масці шару позначаються приховані 

ділянки шару, а білим – повністю відкриті для редагування. Частково 

доступні ділянки шару відображаються на масці за допомогою 

різних градацій сірого кольору. 

У нашому випадку, на мініатюрі  Layer mask thumbnail 

(Мініатюра маски шару) в палітрі Layers, створена маска шару 

повністю залита чорним кольором і тому маскує весь активний шар 

Весна, в результаті чого цей шар на рисунку не видно. Ми бачимо 

нижче розташований шар Літо. 

За замовчуванням маску шару не видно у вікні документа. Для 

її перегляду чи редагування, при натисненій клавіші Alt, клацаємо 
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ЛКМ в палітрі Layers на мініатюрі маски-шару Весна. У вікні 

документа побачимо маску шару, залиту чорним кольором. Щоб 

виключити відображення маски, клацаємо ЛКМ на піктограмі  

Indicates layer visibility шару Весна. 

Заливка маски шару чорно-білим градієнтом 

2. Створити на зображенні плавний перехід від шару Весна до шару 

Літо, для чого залити маску шару Весна чорно-білим градієнтом. 

Білі ділянки маски зроблять відповідні ділянки шару Весна 

видимими, а чорні – невидимими. Сірі ділянки маски зроблять 

активний шар частково прозорим: 

a. Встановити на панелі інструментів білий колір для 

переднього плану і чорний для фону. 

b. Вибрати інструмент  Gradient Tool (G). Вибрати зразок 

градієнту Foreground to Background (Від кольору 

переднього плану до кольору фону). 

c. В палітрі Layers зробити активною маску шару Весна. Якщо 

в палітрі Layers виділити мініатюру із зображенням, то буде 

редагуватись зображення шару, а не маска. 

d. Нарисувати в лівій частині вікна документа лінію градієнту, 

як показано на малюнку. 

 

Рис. 4.6. Лінія градієнта на масці шару весна 
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В початковій точці градієнта маска шару буде залита білим 

кольором, і шар Весна – видимий. У кінцевій точці градієнта, маска 

шару буде залита чорним кольором, і шар Весна – невидимий. 

3. Створити градієнтну маску для шарів Літо і Осінь. 

 

Рис. 4.7. Зображення після заливки градієнтом маски шарів Весна, 

Літо, Осінь 

4. При натисненій клавіші Shift, клацнути ЛКМ на мініатюрі маски 

шару Осінь. Маска буде виключена. Включити маску шару. 

5. Зберегти документ у форматі PSD. 

6. Закрити документ. 

Завдання для самостійного опрацювання 

Завдання 1. Відтворити ефект застосування градієнта: сонячні 

промені, тонування зображення. 

Безкоштовні фотобанки: 

Unsplash, Pexels, Pixabay. 

https://meetingpoint.esclick.me/EKZ1dKhbAJuu
https://meetingpoint.esclick.me/EKZ1i1MqMNOu
https://meetingpoint.esclick.me/EKZ1mi25YRuu
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Приклад 

         

Рис. 4.8. Сонячні промені 

               

Рис. 4.9. Тонування зображення 

Контрольні запитання 

1. Які можливості дають коригувальні шари? 

2. Коригування одночасно всіх шарів. 

3. Індивідуальне коригування кожного шару. 

4. Створення маски шару. 

5. Створення градієнтної маски шару. 

6. Як виключити / включити маску шару? 

7. Як видалити маску шару? 
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Лабораторна робота № 5 

Тема Обрізна маска. Стилі шарів. 

Мета. Набути навичок роботи з обрізною маскою і стилями 

шарів. 

Теоретичні відомості 

Обрізна маска 

Обрізна маска створюється з двох послідовних шарів, де вище 

розташований шар обрізається по границі непрозорих ділянок нижче 

розташованого шару. Для створення обрізної маски спочатку 

необхідно підготовити фон для надпису, потім – сам надпис, а потім 

включити маскування. 

Хід роботи 

1. Відкрити файл 01.jpg з папки з папки Lab5. 

 

Рис. 5.1. Файл 01.jpg з папки Lab5 

2. Перейменувати шар Background на Осінь. 

3. Зберегти файл під іменем 01.psd. 

4. За допомогою обрізної маски створити напис Осінній ліс, в якій 

буквами будуть слугувати фрагменти поточного зображення: 
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a. Здійснити кольорову корекцію шару Осінь, створивши 

коригувальний шар. 

b. Створити новий шар для фону напису і помістити його під 

шаром Осінь. 

c. Виключити відображення шару Осінь. 

d. Залити шар Layers1 зеленим кольором. 

e. На зеленому фоні створити білий напис, наприклад, 

ОСІННІЙ ЛІС (шрифт Arial Black, розмір 170 pt). 

 

Рис. 5.2. Палітра Layers 

f. Створити обрізну маску: включити відображення шару 

Осінь; встановити вказівник на лінії, яка розділяє шари 

Осінь і Осінній ліс; тримаючи Alt, клацнути ЛКМ. Шар 

Осінь обрізається по границях непрозорих ділянок шару 

Осінній ліс. 
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Рис. 5.3. Зображення з обрізною маскою 

5. Виключити / включити відображення шару Layers1. 

Видалити обрізну маску можна, виконавши Layers → Release 

Clipping Mask (Видалити обрізну маску). 

6. Зв’язати шар Осінь з активним шаром Осінній ліс. Перемістити 

шар Осінній ліс у вікні документа. 

7. Відмінити переміщення шару Осінній ліс. 

8. Відмінити зв’язок шару Осінь з активним. 

9. В палітрі Layers зробити активним коригувальний шар 

Hue / Saturation1. За замовчуванням вся маска цього шару 

залита білим кольором, тому налаштування діють на весь нижче 

розташований шар Осінь. 

10. Залити ліву частину маски чорним кольором, щоб маскувати 

ліву частину зображення і захистити його від коригуючих 

налаштувань. 

11. Перемістити маску коригувального шару Hue / Saturation1 на 

малюнку вправо. 

12. Відмінити переміщення маски. 

13. Зробити активним шар Осінь. 

14. Перемістити шар Осінній ліс у вікні документа. Шар 

переміщається незалежно від маски. 
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15. Відмінити переміщення. 

16. Зв’язати шар Hue / Saturation1 з шаром Осінь. 

17. Перемістити активний шар Осінь у вікні документа. 

18. Відмінити переміщення. 

19. Зберегти документ у форматі PSD. 

20. Закрити документ. 

Стилі шарів 

Крім розглянутих налаштувань шарів, які включають режими 

змішування пікселів і непрозорості, до кожного шару можна 

застосувати різні яскраві і привабливі ефекти: тінь, рельєф, 

обведення та ін. Такі ефекти, які об’єднані під загальною назвою 

“стилі шару” (Layer Style), дозволяють швидко змінити зовнішній 

вигляд шару. Стиль шару зв’язаний із його вмістом. Якщо вміст 

шару переміщається чи редагується, то разом з ним модифікуються 

і застосовані ефекти. Наприклад, якщо до напису застосувати 

обведення кольором, після чого змінити текст, то автоматично 

зміниться і обведення. 

Завдання. Застосувати стилі до текстових шарів. 

1. Відкрити файл 02.psd з папки Lab5. Зображення складається з 

чотирьох шарів. 

2.  Для більш виразної дії ефектів створити з текстових шарів 

обрізні маски для двох копій шару Полуниця. 

a. Створити дві копії шару Полуниця і розмістити їх над 

текстовими шарами. 
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b. Створити з текстових шарів обрізні маски для копій шарів 

Полуниця. 

 

Рис. 5.4. Обрізні маски для шарів 

Полуниця copy і Полуниця copy2 

Обрізних масок на фоні того зображення, з якого вони створені, 

не видно. Щоб їх побачити, необхідно виключити відображення 

шарів Полуниця і Ромашка. 

c. Включити відображення шарів Полуниця і Ромашка. 

3. Застосувати ефекти до текстового шару ЛІТО: 

a. Активізувати шар ЛІТО. 

b. Вибрати команду Blending Options (Параметри змішування). 

Включити ефект Bevel and Emboss (Фаска і рельєф): Depth 

370 %, Soften (Пом'якшення) 1 px. Назва кожного ефекту 

відобразиться в палітрі Layers. 

4. Застосувати ефект Bevel and Emboss з такими ж параметрами до 

текстового шару ПРИВІТ: 



68 

 

a. Скопіювати стиль шару ЛІТО в буфер обміну (у 

контекстному меню шару ЛІТО вибрати команду Copy 

Layer Style). 

b. Вставити стиль шару ЛІТО у вказаний шар (у контекстному 

меню шару ПРИВІТ вибрати команду Paste Layer Style). 

Ефект Bevel and Emboss з налаштованими попередньо 

параметрами буде застосований до шару ПРИВІТ. 

5. Застосувати до шару ПРИВІТ ефект Stroke: вибрати жовтий 

колір, товщину обведення 10 px. 

6. Застосувати ефект Stroke з такими ж параметрами до текстового 

шару ЛІТО. 

7. Створити на шарі Ромашка маску, яку залити круговим 

градієнтом. 

a. Перемістити шар Ромашка у палітрі шарів вверх, щоб він 

знаходився над шаром Полуниця. 

b. Додати маску на шарі Ромашка, виконавши Layer → Layer 

Mask  → Hide All. Додана маска повністю маскує весь 

активний шар Ромашка, оскільки залита чорним кольором. 

c. Залити створену маску чорно-білим круговим градієнтом, 

попередньо вибравши білий колір переднього плану і чорний 

фону. 

В центральній частині рисунку, де маска біла – зображення 

ромашки, яке поступово стає прозорим у напрямку до країв рисунку, 

де маска чорна, і в цих місцях стає помітним зображення полуниці, 

яке знаходиться на нижче розташованому шарі. 
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Рис. 5.5. Композиція шарів 

8. Зберегти документ у форматі PSD. 

9. Закрити документ. 

Контрольні запитання 

1. Які є стилі шарів? 

2. До чого прив’язані ефекти? 

3. Режими змішування пікселів. 

4. Як надати об’ємний вигляд зображенню? 

5. Як застосувати стиль з такими ж параметрами до іншого шару? 

6. Як вставити зображення у текст? 

7. Як створити обрізну маску? 

8. Як видалити обрізну маску? 
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Лабораторна робота № 6 

Тема. Фільтри в Photoshop. 

Мета. Розглянути принципи роботи фільтрів, вміти створювати 

різноманітні ефекти для зображень, застосовуючи фільтри 

програми Photoshop. 

Теоретичні відомості 

В програмі Adobe Photoshop фільтри призначені для створення 

різноманітних ефектів. Загалом робота фільтрів полягає у тому, що 

вони аналізують кожен піксель зображення або виділеної ділянки. 

Після цього починається заміна груп чи окремих пікселів іншими 

кольорами, тоном або яскравістю. Внаслідок таких дій на зображенні 

зникають окремі подряпини, підвищується різкість, стають чіткішими 

краї окремих фрагментів, а також накладаються ефекти вітру, 

розмивання, закручування, мозаїки тощо. Вдало застосовані фільтри в 

певній послідовності можуть надати фрагментам ефект вогню, льоду, 

інію, води тощо.  Фільтр можна застосовувати для всього зображення, 

виділеного його фрагмента чи окремого шару. Всі фільтри 

спеціальних ефектів Photoshop доступні за допомогою команд меню 

Filter (Фільтр). 

Фільтри поділяються на дві групи – конструктивні та 

деструктивні. Конструктивні (коригувальні) фільтри застосовуються 

для редагування відсканованих зображень і підготовки зображень до 

друку чи перегляду на екрані. Фільтри дозволяють змінити різкість 

зображення, опрацювати переходи кольорів і усереднити кольори 

сусідніх пікселів. Багато коригувальних фільтрів мають свої 
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антиподи. Фільтр Blur протилежний за своєю дією фільтру Sharpen, 

фільтр Add Noise – фільтру Median і т.д. Проте не можна сказати, що 

один фільтр повністю скасовує дію іншого – відмінити результат 

застосування фільтра можна тільки командою Undo. Більш того, 

протилежні фільтри впливають на контрастність зображення. 

Деструктивні (викривлюючі) фільтри створюють більш 

відчутний ефект. Якщо застосовувати їх неправильно, вони можуть 

повністю “подавити” зображення – результат застосування фільтра 

буде більш помітний, ніж саме зображення. Спотворюючі фільтри 

створюють холодні, строгі ефекти. Але не слід забувати, що фільтри 

порушують первинну чіткість зображення і його композицію. 

Надмірне захоплення фільтрами призводить до збільшення 

обсягу зображення, а також до втрати його оригінальності. 

Крім стандартних фільтрів Photoshop, можуть бути встановлені 

додаткові (вони також називаються плагінами). 

Фільтр Liquify (Пластика, перетворення на рідину), 

Shift+Ctrl+X – інструмент модифікації зображення, який дозволяє 

маніпулювати ділянками, як пластичним матеріалом. Зміни 

відбуваються у вікні попереднього перегляду зображення, що дає 

можливість застосовувати спеціальні інструменти для викривлення, 

кручення, розширення, стиснення, зсуву і дзеркального 

відображення ділянки зображення. Інструмент дає можливість 

виконати ретушування вад чи суттєво змінити зовнішній вигляд для 

створення спеціального художнього ефекту, наприклад, у шаржі. У 

вікні фільтра Liquify працюють із зображенням поточного шару. 

Якщо перед застосуванням фільтра Liquify виділити на зображенні 
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певну ділянку, то у вікні Liquify відобразиться лише ця ділянка і всі 

зміни будуть стосуватись лише її. 

Хід роботи 

1. Відкрити файл 01.jpg з папки з папки Lab6. 

2. Вибрати команду меню Filter → Liquify. 

3. Виключити показ зображення. 

4. Включити відображення сітки. 

5. За допомогою інструмента Freeze Mask Tool (F) вказати 

область, яка буде захищена від дії інструментів фільтра Liquify. 

6. Розглянути дію інструментів вікна фільтра Liquify. 

7. Розглянути різні режими реконструкції (відновлення). 

8. Включити показ зображення. 

9. Отримати результати застосування фільтра Liquify для 

зображень файлів 01.jpg і 02.jpg з папки Lab6. 

  

  

Рис. 6.1. Застосування фільтра Liquify 

10. Зберегти документи. 

11. Закрити документи. 
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12. Відкрити файл 03.jpg з папки з папки Lab6. 

 

Рис. 6.2. Файл 03.jpg з папки з папки Lab6 

13. Виконати обробку зображення, застосовуючи відповідні 

фільтри. 

  

Рис. 6.3. Застосування фільтра 

Гауссове розмиття 

Рис. 6.4. Застосування фільтра 

Кольорові олівці 

  

Рис. 6.5. Застосування фільтра 

Сухий пензель 

Рис. 6.6. Застосування фільтра 

Виділення країв 

  

Рис. 6.7. Застосування фільтра 

Кракелюри 

Рис. 6.8.Застосування фільтра 

Мозаїка 
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14. Зберегти документи у форматі PSD. 

15. Закрити документи. 

Завдання для самостійного опрацювання 

Завдання 1. 

1. Відкрити файл 04.jpg з папки Lab6. 

 

Рис. 6.9. Файл 04.jpg з папки Lab6 

2. Застосовуючи фільтр Liquify, створити шарж, поданий на 

Рис. 6.10. 

 

Рис. 6.10. Застосування фільтра Liquify 

Завдання 2. 

1. Відкрити файл 05.jpg з папки Lab6. 
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Рис. 6.11. Файл 05.jpg з папки Lab6 

2. Застосовуючи фільтр Liquify, виконати перетворення, 

представлені на Рис. 6.12. 

  

Рис. 6.12. Застосування фільтра Liquify 

3. Зберегти документи. 

4. Закрити документи. 

Контрольні запитання 

1. Для чого застосовують фільтр? 

2. Які групи фільтрів у програмі Photoshop? 

3. Як застосувати фільтр до певної ділянки шару? 

4. Застосування фільтрів з Галереї фільтрів. 

5. У якому порядку застосовуються ефекти фільтрів? 

6. Яке призначення фільтра Liguify? 
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Лабораторна робота № 7 

Тема. Створення макета візитних карток. Монограма. Робота з 

мокапами. 

Мета. Вміти працювати з текстовим шаром, якісно презентувати 

розроблений дизайн. 

Теоретичні відомості 

Мокапи – готові графічні шаблони різних об'єктів, які 

використовуються для демонстрації вигляду майбутнього продукту. 

Найчастіше мокапи поширюються у форматі PSD для графічного 

редактора Adobe Photoshop. Вихідні файли складаються з шарів, тому 

за необхідності можна легко внести зміни до готових об'єктів. Mockup 

не показує продукт у динаміці, він відображає лише візуальну 

складову. 

Бібліотеки мокапів: 

https://mrmockup.com/free-mockups/ 

https://cssauthor.com/mockups/ 

https://www.mockupworld.co 

https://mockups-design.com/ – мокапи для рекламної продукції (для 

візиток, флаєрів тощо).  

Безкоштовні ресурси: 

https://www.shopify.com/stock-photos 

https://unsplash.com/ 

https://www.freepik.com/ 

https://www.behance.net/ 

https://mrmockup.com/free-mockups/
https://cssauthor.com/mockups/
https://www.mockupworld.co/
https://mockups-design.com/
https://www.shopify.com/stock-photos
https://unsplash.com/
https://www.freepik.com/
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https://dribbble.com/ 

https://imaggeo.egu.eu/ 

https://publicdomainarchive.com/ 

https://pikwizard.com/ 

https://www.foodiesfeed.com/  

http://www.designerspics.com/  

https://www.flaticon.com/ – бібліотека іконок. 

Хід роботи 

1. Розробити дизайн двосторонньої візитки: розмір 90 × 50 mm + 

4 mm; роздільна здатність 300 dpi; кольоровий режим зображення 

CMYK Color. 

 

Рис 7.1. Приклад дизайну візитки 

2.  Зберегти файл у форматі PSD. 

3. Підготувати макет до друку. Зберегти макет кожної сторони у 

форматі TIFF. 

4. Вибрати mockup візитки. Отримати макет візитки з вашим 

дизайном. 

Ctrl + Shift + Alt +E – створення окремого шару, який є копією 

об’єднаних нижче шарів. 

https://dribbble.com/
https://imaggeo.egu.eu/
https://publicdomainarchive.com/
https://pikwizard.com/
https://www.foodiesfeed.com/
http://www.designerspics.com/
https://www.flaticon.com/
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Рис 7.2. Приклад mockup візуалізації 

5. Зберегти файл у форматі PSD. 

6. Створити ескіз власної монограми. 

 

Рис 7.3. Приклади монограм 

7. Зберегти файл у форматі PSD. 

8. Розмістити монограму на mockup. 

9. Зберегти файл у форматі PSD. 

Завдання для самостійного опрацювання 

Завдання 1. Створити три дизайни кнопок: 

1. З округленими краями та градієнтом. 

2. З гострими кутами та заливкою на вибір (градієнт / суцільна). 

3. Контурну кнопку без заливки. 
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Рис 7.4. Приклад дизайну кнопок. 

Контрольні запитання 

1. Що таке шрифт? 

2. Як створити на активному шарі область за формою символів 

тексту? 

3. Які способи введення тексту в Photoshop? 

4. Як редагувати текст? 

5. Чи можна застосовувати фільтри до текстового шару? 

6. Як конвертувати текстовий шар в растровий? 

7. Які переваги растеризованого тексту? 

8. Які недоліки растеризованого тексту? 

Лабораторна робота № 8 

Тема. Роботам з текстом. Розробка дизайну постера, обкладинки 

каталогу, стікера. 

Мета. Вміти працювати з текстом, векторними елементами, 

створювати текстові ефекти. 

Хід роботи 

1. Розробити дизайн постера або обкладинки каталогу та видання. 



80 

 

 

Рис 8.1. Приклад дизайну обкладинки, постера 

2. Розробити дизайн стікера: кругла форма, текст вздовж контуру. 

               

Рис 8.2. Приклади готових рішень 

3. Зберегти файли в форматі PSD. 

Контрольні запитання 

1. Як створити текст вздовж контуру? 

2. Як перемістити текст вздовж контуру? 

3. Як віддзеркалити текст вздовж контуру? 

4. Як ввести текст всередині замкненого контуру? 

5. Як перемістити контур з текстом? 

6. Як змінити форму контуру з текстом? 
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Лабораторна робота № 9 

Тема. Створення дизайну блоку INTRO веб-сайту. 

Мета. Вміти створювати блочну структуру макета, підбирати 

кольори, шрифти. 

Теоретичні відомості 

Макет сайту – це його реалістичний прототип, створений у 

графічній програмі. Він виглядає як готовий сайт: з усіма блоками 

тексту та зображень, кнопками, фоновими малюнками тощо. Єдина 

відмінність у тому, що у макеті немає функціонального наповнення. 

Сервіси підбору кольорів: 

• ColrD. 

• Cohensive Colors. 

• ColorHunter. 

Хід роботи 

1. Створити макет сайту у Adobe Photoshop: розмір 1920 × 1080 px; 

роздільна здатність 72 dpi; кольоровий режим зображення 

RGB Color. Тема сайту довільна. 

2. Зберегти документ в форматі PSD. 

 

 

 

 

 

http://colrd.com/
http://javier.xyz/cohesive-colors/
http://www.colorhunter.com/
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Рис 9.1. Приклади готових рішень 

3. Зробити опис макета сайту. В описі зафіксувати основні 

характеристики макета: вибрані кольори, розміри сітки, описи 

базових елементів тощо. 

Контрольні запитання 

1. Як задати модульну сітку? 

2. Як виконати групування елементів? 

3. Які переваги растрової графіки? 

4. Що є основним об’єктом векторного зображення? 

5. Яка різниця між растровим і векторним зображенням? 

6. Який вид графіки використовується в Adobe Photoshop? 
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Лабораторна робота № 10 

Тема. Створення анімованого банера. 

Мета. Набути навичок роботи з анімацією руху в 

Adobe Photoshop. 

Теоретичні відомості 

Анімація є послідовним відображенням кадрів один за одним. 

У такий спосіб через швидку зміну кадрів створюється ефект руху 

зображення. Кількість кадрів на секунду може бути від 12 для 

мальованої анімації до 30 для комп’ютерної. Для більш простої 

анімації кількість кадрів може бути меншою. Adobe Photoshop 

дозволяє створювати різні види анімації: покадрову та за ключовими 

точками. 

Для анімації при створенні документа вибираємо пункт 

Film & Video (Фільми та відео), режим кольору найчастіше RGB, 

роздільну здатність – 72 ppi, бітову глибину – 8 біт / канал. 

Панель Timeline (Шкала часу) 

При використанні панелі Timeline кожен шар з панелі Layers 

розташовується на окремій часовій доріжці, але при цьому, якщо 

шари згруповані в папку, то папка буде розташована на часовій 

доріжці як шар. Будь-які зміни на панелі Layers миттєво 

відображатимуться на панелі Timeline. Для перемикання між 

режимами покадрової і тимчасової шкали на панелі Timeline є 

кнопка Convert to…. 
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Рис 10.1. Палітра Timeline 

Анімацію у Adobe Photoshop часто використовують для 

створення анімованих банерів. 

Хід роботи 

1. Розробити дизайн банера для реклами: розмір 1000 × 1000 px; 

роздільна здатність 72 dpi; кольоровий режим зображення 

RGB Color. Тема – довільна. 

2. Створити і розмістити всі елементи для банера на окремих шарах. 

3. Ввімкнути панель Timeline. 

4. Використати шкалу часу для створення анімації. Кожен із шарів 

розміщується на окремій шкалі часу. 

5. Створити анімовані елементи на банері. 

6. Зберегти файл у форматі GIF (Alt + Ctrl + Shift + S). 

Контрольні запитання 

1. Як створюється ефект руху зображення? 

2. Які види анімації можна створювати в Adobe Photoshop? 

3. Як перейти з анімації по часовій шкалі в покадрову? 

4. Які є принципи створення анімації? 
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Лабораторна робота № 11 

Тема. Колажування в Photoshop. 

Мета. Набути навичок роботи з багатошаровим зображенням. 

Хід роботи 

Колажування використовується для створення привабливої 

картинки для публікації в соцмережах, при розміщенні на рекламних 

буклетах, журналах, презентаціях, етикетках, упаковках, листівках 

тощо. Найбільш поширене колажування у Adobe Photoshop. 

1. Створити колаж на довільну тему (із застосуванням різних 

ефектів, фільтра, тексту). 

2. Зберегти файл у форматі PSD. 

 

 

  

 

Рис 11.1. Приклади готових рішень 
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Контрольні запитання 

1. Яким чином можна збільшити яскравість і контрастність 

фрагмента зображення? 

2. Як можна зробити шар частково прозорим? 

3. Які способи заповнення фону при створенні нового файлу.  

4. Якщо колаж зберегти в двох форматах – pdf і jpg, у чому будуть 

відмінності в результуючих файлах? Як співвідносяться розміри 

отриманих файлів? 

5. Які фактори якості впливають на комбінацію растрових і 

векторних зображень? 

Лабораторна робота № 12 

Тема. Проєкт дизайну: підготовка до дослідження. 

Мета. Розглянути етапи дослідження, необхідні для свідомої та 

продуктивної роботи. 

Теоретичні відомості 

Проєкт графічного дизайну можна розглядати як послідовність 

виборів – і що усвідомленіший вибір на кожному етапі, то кращий 

результат. Дослідження – це інструмент, за допомогою якого можна 

глибоко вивчити предмет, і вже на основі здобутого знання обирати 

серед можливих варіантів і ухвалювати вдалі та обгрунтовані 

рішення. Дослідження починається із первинного пошуку даних на 

основі запитів брифу, а потім через дослідження аудиторії веде до 

розробки та синтезу ідей – і аж до кінцевого тестування матеріалів, 

процесів та рішень. 
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“Дослідження – це бачити те, що бачили всі решта, 

і думати так, як не думав ще ніхто”. 

Альберт Сент-Дьорді 

Загалом методи дослідженння можна поділити на три категорії: 

• Первинне дослідження – це нова праця, що виникає в 

результаті вашої розвідки. Це будь-яке дослідження, що ви 

проводите самі, включно з інтерв’ю, анкетуванням і 

опитуванням. 

• Вторинне дослідження базується на дослідженнях і оглядах, 

зроблених до вас. 

• Третинне дослідження – це зведення результатів багатьох 

вторинних досліджень для формування висновків. 

Можна зважувати різні варіанти рішення шляхом аналізу 

точних фактів і цифр (у кількісних методах зазвичай задіяно анкети 

чи тести). Можна використовувати описові відповіді (у межах 

якісного дослідження члени фокус-групи описують власні реакції на 

дизайн). Аналітичні і пропозиційні методи дослідження спонукають 

виокремлювати конкретні проблеми та знаходити нові інноваційні 

рішення. 

Хід роботи 

Необхідно розробити новий бренд для компанії, яка прагне по-

новому, у різні способи приваблювати соціально активних підлітків. 

Компанія планує розробляти та промотувати лінійку смартфонів, які 

легко кастомізуються, а до того ж вони достатньо доступні й 

технологічно просунуті, щоб змагатися з відомими брендами. 
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Компанія прагне неформально й безпосередньо спілкуватися зі 

своєю аудиторією. 

1. Використовуючи лише ручку та папір, розглянути різні методи 

дослідження та техніки, які ви можете застосувати, щоб зібрати 

інформацію, необхідну для розуміння аудиторії та визначення 

найкращого підходу: 

• Чи будете ви спілкуватися з членами цільової аудиторії і, 

якщо так, як ви її визначатимете, який спосіб спілкування 

оберете? 

• Що буде ефективнішим – анкетування чи опитування? 

• Яке вторинне дослідження можна провести, де ви будете 

шукати відповідну інформацію? 

• Як ви визначатимете та вивчатимете бренди-конкуренти? 

• Яку інформацію ви можете отримати з цього дослідження і 

як її можна використати в проєкті? 

Контрольні запитання 

1. Яким чином методи кількісного дослідження допомагають 

зрозуміти цільову аудиторію? 

2. Яким чином методи якісного дослідження допомагають 

зрозуміти цільову аудиторію? 

3. Коли доцільно застосовувати методи описового дослідження? 

4. Що являє собою пропозиційне дослідження? 

5. Що являє собою аналітичне дослідження? 

6. Як називається наука що вивчає різні системи знаків? 
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Лабораторна робота № 13 

Тема. Первинне дослідження контексту дизайну, аудиторії, 

соціальних факторів. 

Мета. Набути навичок первинного дослідження в певному 

контексті. Визначити особливості, які вирізняють продукти 

відомих брендів. 

Теоретичні відомості 

Розробляючи дизайн для певного ринку, необхідно вивчити 

його поточний стан. Аналізуючи дизайн у межах відповідного 

контексту, можна дізнатись про його конвенції та краще зрозуміти 

наявні можливості. Наприклад, прийняти вже наявні тренди та ідеї 

чи відхилити їх на користь чогось нового. 

Хід роботи 

1. Проаналізувати низку товарів у супермаркеті за таким списком: 

• Пральний порошок. 

• Консервований суп. 

• Кола. 

• Печиво. 

• Мюслі. 

Можна трохи звузити вибір (наприклад, тільки мюслі для дітей). 

2. Коли товари для огляду обрано, проаналізувати презентацію і 

упаковку. Звернути увагу на: 

• Колір. 

• Типографію й летеринг. 
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• Масштаб. 

• Матеріал. 

• Використання зображень. 

• Цільову аудиторію. 

3. Визначити, які спільні риси мають обрані продукти і які риси 

можна назвати незвичайними чи унікальними для певного 

бренду. Які характиристики вам здаються найважливішими та 

найефективнішими? 

Контрольні запитання 

1. Історія мистецьких течій: рух мистецтв і ремесел; імпресіонізм; 

пуантилізм; ар-нуво; футуризм. 

2. Що ви розумієте під впізнаваністю стилю? 

3. Яке значення для вас має дослідження? 

4. Які методи дослідження ви вважаєте найефективнішими? 

5. У чому ви знаходите натхнення? 

Лабораторна робота № 14 

Тема. Дослідження цільової аудиторії. 

Мета. Створити детальний профіль уявного представника 

аудиторії. 

Хід роботи 

1. Переглянути рекламу в журналах та вибрати один товар із 

сектору luxury. 

2. Визначити шляхом припущень щодо ринку товарів: 
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• Цей товар переважно розрахований на чоловіків чи жінок? 

• Яким приблизно має бути дохід цільової аудиторії? 

• Цільова аудиторія – родини, одружені чи неодружені люди? 

• Чи висока купівельна спроможність цих людей? 

• Чи висока ймовірність того, що цільова аудиторія має власне 

житло? 

• Яку їжу вони обрали б, роблячи закупи на тиждень? 

• Одяг яких брендів вони купують? 

• Якою машиною вони їздять? 

3. У магазині поспостерігати за тим, як люди купують продукти 

однієї з категорій: 

• Електротехнічні товари. 

• Товари для здоров’я та краси (косметика, медичні товари). 

4. Вибрати один конкретний продукт і зосередитись на ньому. 

Проаналізувати: 

• Які ще продукти є в цій категорії? 

• Як конкуренти презентують свою продукцію? 

• Особливості матеріалів, конструкції та дизайну. 

Коли хтось купує продукт, звернути увагу на їхній одяг і на те, 

що вони купують – це може дати певне уявлення про профіль 

клієнта. Можна спробувати більше дізнатися про цих клієнтів – 

запитати, що їх привабило до певної позиції або чи купували вони 

цей товар раніше. 

Контрольні запитання 

1. В які способи можна проводити дослідження аудиторії? 
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2. Які переваги і недоліки включеного і невключеного 

спостереження? 

3. Описати способи визначення аудиторії для опитування. 

4. Які переваги інтерв’ю над анкетуванням чи опитуванням? 

5. Коли застосовують метод фокус-групи? 

6. Які ви знаєте методи польових досліджень, які їхні особливості? 

7. Яка перевага методу вивчення кейсів? 

Лабораторна робота № 15 

Тема. Аналіз даних дослідження. 

Мета. Набути навичок первинного дослідження. Визначити 

системи, які можна застосувати для оцінювання та класифікації 

результатів дослідження. 

Теоретичні відомості 

Поки результати дослідження належно не впорядковано, важко 

зрозуміти, що може виявитися найбільш корисним, а де проявилися 

повторювані схеми й тенденції. Коли ви впорядкуєте дослідження, 

буде простіше почати процес синтезу, виокремлюючи найбільш 

продуктивні напрями і відкидаючи решту. 

Хід роботи 

1. Зафіксувати і класифікувати певну кількість інформації. За 

допомогою цифрової камери зняти якомога більше знаків на 

перехресті зі жвавим рухом. 
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2. Коли назбирається значна кількість даних для роботи, знайти 

спільні риси, які можна використати для класифікації даних. 

Це може бути: 

• Типографічний стиль. 

• Колір. 

• Використання знака. 

• Призначення знака. 

• Цільова аудиторія. 

• Матеріал. 

• Розташування. 

Інколи той чи інший знак можна класифікувати за кількома 

ознаками, і тоді можна зробити перехресні посилання між 

вибірками. 

Контрольні запитання 

1. Як дані можна класифікувати, синтезувати, відображати, 

аналізувати? 

2. Які є підходи до класифікації даних? 

3. Коли є ефективним метод контент-аналізу? 

4. На яких етапах проєкту доцільно проводити тестування? 

5. Які переваги користувацького тестування? 
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Лабораторна робота № 16 

Тема. Презентація даних дослідження. 

Мета. Дослідити, як статистичні дані можна представити за 

допомогою інфографіки. 

Хід роботи 

1. Зібрати статистичні дані для проведення дослідження 

(наприклад, дослідити поточні ціни на житло у вашому регіоні та 

порівняти їх з історичними даними, інформацію можна знайти в 

інтернеті). 

2. Створити інноваційну та інформативну презентацію, яка донесе 

інформацію в захопливий та цікавий спосіб. 

Плануючи роботу, розглянути: 

• Як представити отримані дані – які факти необхідно 

показати, на що цікаве та важливе вони вказують? 

• Як візуалізувати дані – презентація, переповнена числами, не 

зацікавить глядача, як і діаграми та графіки. Що можна 

додати до презентації, щоб чітко представити інформацію та 

зацікавити аудиторію? 

• Чи можна застосувати сторітеллінг, щоб зробити інформацію 

доступнішою? 

• Презентацію буде представлено за допомогою проектора чи 

надруковано? Чи включатиме вона відео або інтерактивні 

елементи? Чи будете ви використовувати макети й моделі для 

ілюстрації своїх міркувань? 
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Розглянути презентацію дослідження як дискусію: вам треба 

довести аудиторії правильність своєї гіпотези. Чіткість – запорука 

ефективної презентації дослідження. Висновки мають бути ясно 

сформульованими й зрозумілими, а кожна складова повинна вести 

від брифу до запропонованого рішення. Є багато способів показати, 

що було зроблено, головне, щоб обраний спосіб був прийнятним для 

аудиторії. Щоб полегшити сприйняття, звернути увагу на методи 

синтезу великих обсягів даних через сторітеллінг та візуалізацію. 

Контрольні запитання 

1. Як можна візуалізувати результати дослідження, щоб 

переконливо презентувати саме дослідження та процес дизайну? 

2. Що таке система Isotype? 

3. Коли можна презентувати дослідження з використанням 

сторітеллінгу? 

4. Які переваги застосування макетів і моделей при демонстрації 

своєї ідеї аудиторії? 
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